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ABSTRACTS 

Aspirin and other non-steroidal anti-inflammatory drugs (NSAIDs) have long been used in the treatment of 

colorectal cancer and other neoplasm whose underlying efficacy and biomolecular mechanism is generally 

believed to be through induction of Bax protein among others resulting in cell apoptosis but its toxicity 

precludes its chemotherapeutic benefits. However, there exists a dearth of knowledge on the use of other more 

efficacious and more tolerable novel aspirin analogues with better prognosis. The purpose of this study was to 

investigate Bax induction on SW480 cells treated with 0.5mM aspirin and novel aspirin analogues; PN508 

(bis-carboxylphenol-succinate), PN517 (Fumaroyldiasprin) and PN529 (Isopropyl m- 

bromobenzoylsalicylate) measured after 48 hours of incubation at 370C using analytical digital 

photomicroscopy. 

The results of this study showed a 60-70% folds increase in Bax expression in 0.5mM Aspirin treated cells. 

0.5mM PN517 and PN529 treated cells showed 70-80% folds increases in Bax expression whilst 0.5mM 

PN508 treated cells showed a significance of 100-120% folds increase in Bax expression. 

This study reports that 0.5mM aspirin and novel aspirin analogues PN508, PN517 and PN529 caused increase 

in Bax expression when exposed to SW480 cells at 370C for 48 hours. It could be inferred from the results of 

this study that novel aspirin analogues PN508, PN517 and PN529 are potentially more potent inducers of Bax 

protein than aspirin in SW480 cells. 

We therefore recommend that these novel aspirin analogues be considered in designing alternative and more 

efficacious drugs for the treatment of colorectal cancer and other neoplasm in the nearest future. 
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INTRODUCTION  

Colorectal cancer is a malignant tumour that affects the colon, rectum and appendix 

 Commonly found in adults age 50 years and above. It is the third most common cancer in men and the second 

most common cancer among women affecting about 1.23 million people worldwide resulting in half a million 

related deaths annually (1,2). High incidence of colorectal cancer reported in developed countries has been 

linked with excessive consumption of red meat and dairy product (3, 4). Studies carried out in 2007 showed 

that there were 38,608 new cases of large bowel cancer registered in united kingdom approximately two-third 

in the colon and one-third  in the rectum (5) whilst over 1million people were diagnosed of colorectal cancer 

in United State of America the same year (6). In West Africa especially in Nigeria, a low incidence of this 

disease with a prevalence rate of approximately 3 per 100,000 people per population has been reported (7- 8) 

whilst a steady rise in its incidence from 1.9 to 3.2 and 4.9 per 100,000 people per population in men and 

women respectively have been reported in south East Asia (9).  

Currently known and documented predisposing factors of colorectal cancer include but not limited to genetic 

predilection such as hereditary non-polyposis colorectal cancer (HNPCC) or Lynch syndrome, consumption 
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of 100g/day of red meat, obesity, alcoholism and tobacco smoking, Diabetic Mellitus type II, ulcerative colitis 

and Crohn’s disease among others   (10 -14). It is now widely accepted that colorectal carcinogenesis is a 

multistep process involving the activation and inactivation of a variety of well-defined tumour suppressor 

genes, oncogenes and DNA mismatch repair genes (15). In addition, epigenetic alterations through aberrant 

promoter methylation and histone modifications also play a major role in the evolution and progression of 

colon cancer (16).  

Moreover, aspirin, a member of non-steroidal anti-inflammatory drug mostly prescribed initially as pain 

reliever, fever and rheumatism therapy is currently being used in the treatment and chemoprevention of 

colorectal cancer and other related neoplasm (17-19). Varied underlying biomolecular chemotherapeutic 

mechanisms of aspirin action have been postulated and documented. 

Aspirin has been shown to inhibit cyclooxygenase-2 (COX-2) enzyme believed to promote inflammation and 

cell proliferation often over expressed in colorectal cancer thus, demonstrating the anti-inflammatory and anti- 

proliferative activities of aspirin against colorectal cancer (20, 21). Aspirin has been proven to be protective 

against colorectal tumourigenesis through the release of cytochrome c from the mitochondrial and inhibition 

of proteasome function, alterations of the Nuclear Factor kappa B (NFkB) signalling pathway, decreases 

intracellular polyamines content , inhibit nterleukin-6, STAT3 signalling pathways and their downstream anti 

apoptotic gene Bcl-2 and Bcl-xl, Bax induction among others to orchestrate cell apoptosis (22- 26). 

                    

Figure 1 shows the structure of salicylic acid and aspirin. 

 Salicylic acid is the precursor of aspirin with the absence of acetyl group found in aspirin (27) 

Meanwhile, aspirin analogues are structurally modified form of aspirin whose molecules differ only from 

aspirin by transposition of one or more functional groups for another and have been used as anti- 

inflammatory and anti -thrombotic agent (28). Aspirin analogues mostly widely used as antithrombotic agents 

involves additional carboxylate substituent to acetylsalicylate and has been proven to have fewer side effect 

than aspirin (29). Nitric oxide donating aspirin (No-aspirin) is another aspirin analogue that has been used in 

the treatment of colon cancer and the rationale behind it is addition of nitric oxide to the carboxyl chain (30) 

and has been shown to have fewer side effects than aspirin.  

 

Figure: The structure of aspirin, Diaspirin (PN508) and Fumaroyldiasprin (PN517)   
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 The role of Bax, a pro-apoptotic protein of Bcl-2 gene family in cell apoptosis has long been identified. 

Evidence exist that Bax promote apoptosis (programmed cell death) by competing with Bcl-2 anti-apoptotic 

protein. Studies carried out by Chiu et al., (31 ) demonstrated that Bax induces apoptosis through the release 

of cytochrome c from mitochondrial with consequence loss of mitochondrial membrane potential, caspase 

activation, chromatin condensation and fragmentation, and that no apoptosis will occur in the absence of 

BAX. The work of Lin et al., (32) also demonstrated the role of Bax in the apoptotic response of malignant 

cells to anticancer therapy. It was evident from the study that the absence of BAX completely abolished the 

apoptotic response of malignant cells to chemo- preventive sulindac and other non-steroidal anti-inflammatory 

drugs (NSAIDs). In a related study by Lai et al., (33) it was shown that Bax was up-regulated with down 

regulation of Bcl-2 in apoptotic COX-2 negative colon cancer cells treated with aspirin. Therefore it was 

evident that increase in BAX expression correlate well with the number of apoptotic nuclei in malignant tissue 

when exposed to anticancer agents (34). 

Furthermore, Irinotecan is a semisynthetic derivative of camptothecin, a water soluble cytotoxic alkaloid 

extract from a plant called camptotheca acumunata first discovered and synthesized in Japan in 1983. Its 

chemotherapeutic effect causing S-phase specific cell killing has long been employed in the treatment of 

colorectal cancer and other carcinogenesis (35). Evidence exist that Irinotecan causes apoptosis of cells by 

interacting with cellular topoisomerase 1 DNA (TOPO 1) complexes and has S-phase specific cytotoxicity 

(36). Topoisomerase is an enzyme believed to reduce DNA twisting and supercoiling that occur at selected 

regions of DNA during replication, transcription and repair combination thus repairing reversible single strand 

DNA break however upon interaction with Irinotecan active metabolite SN-38 (7-ethyl-10-hydroxyl 

camptothecin), the formation of a double stranded DNA breaks occur leading to the irreversible arrest of cell 

replication and death (36). In addition the interaction of SN-38 with TOPO 1 has also been reported to cause 

G2 arrest/delay by signalling the presence of DNA damage to an S-phase check point (37). At higher 

concentration of Irinotecan, the killing of non S-phase cells has also been suggested of which mechanism 

appears to be related to transcriptionally mediated DNA damage and of apoptosis (38).  

It is obvious from the result of different study that the mechanism of action of aspirin used in the treatment 

and prevention of colorectal cancer and other neoplasm is by induction of apoptosis demonstrable with Bax 

expression.  

Although the efficacy of aspirin in the treatment and chemoprevention of cancers has been widely 

acknowledged however, the short and long term toxic effect may far much outweigh its benefits. Evidence 

exists indicating that the long term usage of aspirin causes intestinal haemorrhage (39, 40). McGovern et al. 

(41) established an association between Reye’s syndrome (Encephalopathy and fatty liver) and aspirin usage 

in children and adult. D’Agati, (42) also demonstrated in his work that aspirin could increase the risk of end 

term renal failure when used over a long period of time. Long term usage of aspirin has also been reported to 

cause anaphylactic angioedema (43, 44) 

The focus of research so far has been on chemotherapeutic efficacy of aspirin in the treatment and prevention 

of colorectal cancer and its long term cytotoxic cumulative consequences. However, there exist a dearth of 

knowledge on the use of other novel aspirin analogues with better efficacies and less cytotoxicity than aspirin 

that could be explored for their potential use in the treatment and prevention of colorectal cancer and other 

neoplasm. It was based on this insight that the present study was designed to determine the expression of Bax 

protein on colorectal cancer cells exposed to aspirin and novel aspirin analogues PN508 (bis-carboxylphenol-

succinate) and PN517 (Fumaroyldiasprin) and PN529 (Isopropyl m- bromobenzoylsalicylate). 

MATERIALS AND METHODS 

Reagents used in this study were purchased from Sigma-Aldrich company Ltd. (The Old Brick Yard, New 

Road, Gillingham, Dorset SP8 4XT) and the cell line was purchased from the European collection of cell 

culture (ECACC, Health Protection Agency, Centre for Emergency Preparedness and Response, Porton 

Down, Salisbury Wiltshire, SP4 0JG) unless otherwise stated.  
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Cell Culture 

SW480 cells (human colorectal adenocarcinoma) were cultured in vitro in 75 cm2 non vented cultured flasks 

(sarstedt Ltd., 68 Boston Road, Beaumont Leys, Leicester, LE4 1AW) in L-15 Leibovitz medium 

supplemented with 10% Fetal Calf Serum (FCS) (PAA Laboratories Ltd., Termare Close, Houndstone 

Business Park, Yeovil, Somerset, BA22 8YG) and 1% antibiotic solution [200mM L-glutamine/ 10,000 

units/ml penicillin/ 10mg/ml streptomycin solution] in a class 1 hood using aseptic technique, sterile reagents 

and equipment, thereafter incubated at 370C in CO2  free incubator until 80 – 90% confluence was attained. 

Subculture of Cell Line 

When cells reached 80 - 90% confluence, it was sub cultured using the following technique under class 1 

safety hood. The medium was removed by aspiration and cells were gently washed with 4 mls of trypsin to 

remove the remaining serum which will inhibit the action of trypsin and prevent the detachment of cells. This 

4 mls of trypsin was then removed by aspiration and a further 4 mls of trypsin was added to the flask mixed 

gently and incubated at 370C for 5 minutes in a CO2 free incubator. The flask was removed thereafter and 

mixed very well until the cells had detached completely and this was confirmed under the microscope. 

 Six mls of pre- warmed L-15 medium was then added to the trypsinised cells and was mixed gently to 

inactivate the trypsin. One ml of the suspension was removed for cell count as follows: 

 A modified Neubauer haemocytometer was loaded with 10µl of the cell suspension and the cells occupying 

the four large corner squares were counted and the average was calculated to estimate the number of cells per 

ml. Thereafter an aliquot of the cell suspension was removed from the flask and made up to 25 mls with a 

fresh and pre warmed medium and was gently mixed. Four mls of the re-suspended cells were seeded onto a 

sterile cover slip in a six well flask (Sarstedt) at a concentration of 120,000cells/well and then sealed with a 

plate seal (MP Biomedicals, Ohio, USA) thereafter placed in a moisturized container and incubated for 48 

hours at 370C in a CO2 incubator.  

Preparation and Addition of Compounds 

 Fresh stock solutions of 0.5 M aspirin (Sigma, UK), PN508, PN517 and PN529 were made by dissolving a 

predetermined weight of each compound in an appropriate volume of Dimethylsulfoxide (DMSO). These 

were then diluted to 0.5mM with appropriate volume of pre warmed L-15 medium. Similarly 10mM stock 

solution of Irinotican was prepared and diluted to 25uM with appropriate volume of pre warmed L-15 medium 

and was used as positive control whilst equal volume of DMSO treated in a similar way was used as negative 

control. After the preparation of compounds the flask was removed from the incubator and examined under 

the microscope for cell viability. Thereafter, the medium was removed by aspiration aseptically in a class 1 

safety hood. The flask was labelled and 4 mls of each compound was added to the appropriate well with 

Irinotecan as positive control and DMSO as negative control, sealed with a plate seal, placed in moisturized 

container and incubated at 370C in a CO2 incubator for 48 hours.  

Immunohistochemistry 

After 48 hours incubation, the medium was removed with plastic pipettes carefully to avoid damaging the 

cells and then washed once with 2 mls of phosphate buffered saline to remove excess medium. The coverslips 

were fixed in methanol for 2 minutes followed by acetone for 2 minutes and then washed twice in PBS. This 

was aspirated off with a plastic pipette. Endogenous peroxidase activity was blocked by incubation for 5 

minutes with 2 mls of 3% H2O2 in water at 370C in CO2 incubator, rinsed in water three times and then 

washed twice in PBS. The PBS was aspirated off and replaced with a blocking agent [3% BSA (w/v)/PBS 

0.2% TWEEN 20] and then incubated for 20 minutes at 370C in CO2 incubator to prevent nonspecific binding. 

The blocking agent was removed with a plastic pipette and replaced with primary antibody (anti-BAX-HRP) 

diluted 1:150 with blocking agent prepared immediately before use. This was covered with a lid to prevent 

sample dehydration and then incubated at room temperature for 1 hour with rocking. After incubation the 

medium was removed with a plastic pipette carefully then coverslips washed 3 times with wash buffer [1% 

(w/v) BSA in 0.2% v/v TWEEN 20 in PBS]. The buffer was aspirated off using plastic pipette and the 
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coverslips washed twice with PBS. TMB reagent was then added to act as substrate for HRP and was 

incubated for 5 minutes at room temperature. Thereafter the substrate was removed with a plastic pipette and 

the coverslips rinsed with 5 mls of ultra-pure water 3 times to stop the reaction. The coverslips were then 

removed carefully from the flask and dried against the edge of a tissue paper and then mounted by inversion 

onto a clean slide with a drop of vectashieldTM mounting agent (Dako). 3 photographs of each coverslip were 

taking to obtain the average of each pixel value using white balance settings and 5 megapixel imaging. These 

were then analyzed using analytical digital photomicroscopy (ADP) as outline by Biocolor Company UK. The 

digitally acquired images were posterized using Adobe Photoshop software where the blue pixels (as the 

substrate conversion resulted in blue stains) were counted in each image and recorded to give quantitative 

values for comparative analysis. Instat and graph pad prism were used for the statistical analysis. 

The pathway utilized for Adobe Photoshop software was: 

Layer > New adjustment layer > Posterize (a constant value of 4 utilized for all images) > Layer > Flatten 

image > Select >Colour range > Blues > OK > Histogram > Pixels  

Results 

(A)                                                                       (B)                                                                           

               

(C)                                                                         (D) 

        

(E)                                                                      (F) 

    

Figure 1 (A-F) 

https://rsisinternational.org/journals/ijrsi
https://rsisinternational.org/journals/ijrsi
http://www.rsisinternational.org/


INTERNATIONAL JOURNAL OF RESEARCH AND SCIENTIFIC INNOVATION (IJRSI) 

ISSN No. 2321-2705 | DOI: 10.51244/IJRSI |Volume XII Issue IX September 2025 

Page 3449 
www.rsisinternational.org 

  

    
(A) Posterized image of SW480 cells treated with 25µM DMSO used as negative control. (B) Posterized 

image of SW480 cells treated with 25µM Irinotecan used as positive control. (C) Posterized image of SW480 

cells treated with 0.5mM PN508. (D) Posterized image of SW480 cells treated with 0.5mM aspirin. (E) 

Posterized image of SW480 cells treated with 0.5mM PN517 and (F) Posterized image of SW480 cells treated 

with 0.5mM PN529. 

Assessment of cellular response of SW480 cells to aspirin and novel aspirin analogues. 

Bax induction has been used as early marker of apoptosis and previous studies have shown that Bax was 

upregulated in apoptotic colon cancer cells treated with aspirin (Lai et al., 2008; Teles et al., 2008). However, 

there has not been any documented evidence of previous study with novel aspirin analogues PN508, PN517 

and PN529. To investigate whether Bax induction is increase on exposure of each compound to cancer cells. 

SW480 cells were treated with 0.5mM aspirin, PN508, PN517 and PN529 for 48 hours at 370C repeatedly in 

different experiments to ascertain the reproducibility of result (Figure 2A, 2B and 2C). There was significant 

increase in Bax induction in PN508 treated cells (P < 0.05) whilst Bax induction in cells treated with aspirin, 

PN517 and PN529 were moderately increased but not statistically significant (P > 0.05) compared to the 

control.  
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 Figure 2  Graphical assessment of SW480 cells incubated with 25µM DMSO (Negative control), Irinotecan 

(Positive control) and 0.5mM PN508, PN517 and PN529 respectively for 48 hours at 370C repeatedly at 

different time (Fig 2A-2C). There was a consistent increase in Bax induction with aspirin and novel aspirin 

analogues compared to the control (PN508, P < 0.05; ASP, PN517 and PN529, P > 0.05). 
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Assessment of the degree of Bax induction 

Previous studies have demonstrated that Bax was upregulated in colon cancer cells treated with aspirin (Lai et 

al., 2008; Teles et al., 2008) but the extent and degree of Bax induction has not been previously investigated 

with this compound.  More interestingly, this study is the first to investigate the extent of Bax induction with 

novel aspirin analogues PN508, PN517 and PN529. To demonstrate the relative increase in Bax induction, 

SW480 cells were treated with 0.5mM aspirin and novel aspirin analogues for 48 hours at 370C repeatedly to 

ascertain reproducibility of result and Bax inductions quantified using analytical digital photomicroscopy 

(ADP). Pixel numbers obtained from posterized images were transformed into percentage values and assessed 

graphically (Figure 3A, 3B and 3C).  Aspirin treated cells  showed 60% -70% fold increase in Bax induction,  

PN517 and PN529 treated cells showed 70% – 80%  folds increases in Bax induction  whilst PN508 treated 

cells showed 100% - 120% fold increase in Bax induction compared to the control. 

3A                                                                                          3B 
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Figure 3 The degree of Bax induction on SW480 cells exposed to 25µM DMSO (Negative control), 25µM 

(Positive control) and 0.5mM of aspirin, PN508, PN517 and PN529 repeatedly for 48 hours at 370C. Aspirin 

treated cells showed 60-70% fold increase in Bax induction, PN517 and PN529 treated cells showed 70-80% 

folds increases in Bax induction whilst PN529 showed  100-120% fold increase in Bax induction  (Fig.  3A, 

3B and 3C) compared to control.  

DISCUSSION 

Effect of aspirin on Bax induction 

Bax induction has been used as an early marker of apoptosis of cancer cells treated with aspirin and has been 

shown to correlate well with the number of apoptotic nuclei (33, 34). However attention has become more 

focused on the need to source for alternative drugs that is more efficacious with fewer side effects than aspirin 

for the treatment of cancer as long usage of aspirin has been known to cause cytotoxicity. Therefore, to 

establish the basis for comparism with novel aspirin analogues, cellular response of SW480 aspirin treated 

cells were investigated.  There was 20-30% increase in Bax induction in SW480 cells treated with 0.5mM 

aspirin compared to the positive control whilst 60-70% fold increase was observed compared to negative 

control (Fig. 2A, 2B, 2C, 3A, 3B and 3C). Previous studies have demonstrated that Bax induction was 

upregulated in cancer cells treated with aspirin suggesting its basis for use in cancer treatment (Lai et al., 

2008; Teles et al., 2008). This study is therefore in consonance with such finding suggesting that aspirin 

causes apoptosis of cancer cells. However, no statistical significance difference was observed between the 

mean values of aspirin and the controls (P > 0.05) possibly due to fewer sample size and such limitation may 

have to be considered in future experiment. 

Effects of PN517 and PN529 on Bax induction 

Aspirin long usage for the treatment of cancer and other neoplasm has been shown to cause cytotoxicity. The 

need to source for an alternative drug has become inevitable. Attempts were made to compare the effect of 

aspirin with its novel analogues PN508, PN517 and PN529 on SW480 treated cells using Bax expression as 

an index of apoptosis. There was 30-40% folds increases in Bax induction in PN517 and PN529 treated cells 

compared to the positive control whilst 70-80% folds increases in Bax induction was observed compared to 

negative control (Fig. 2A-2C and 3A-3C). Interestingly evidence of previous study demonstrating the effects 

of these compounds (PN517 and PN529) on Bax induction with cancer cells does not exist suggesting that this 

study is the first to investigate the induction of Bax with these novel aspirin analogues. The percentage folds 

increases in Bax induction are suggestive of the apoptotic potency of these compounds on cancer cells and 

therefore this finding could be relevant when designing new drugs for cancer chemotherapy. However, there 

was no statistical significant difference between the mean values and the controls (P > 0.05) probably due to 

fewer sample size.  In addition, there is the need to further investigate the cytotoxicity of these compounds in 

future experiment as this could not be established in this study.        

Effect of PN508 on Bax induction 

 In the quest for alternative drugs for the treatment of colorectal cancer and other neoplasm, the effect of 

PN508 on SW480 treated cells using Bax expression as a measure of apoptosis was investigated. There was 

40-50% fold increase in Bax induction compared to the positive control whist 100-120% fold increase was 

observed compared to the negative control (Fig. 2A-2C and 3A-3C) suggesting that PN508 is potent at 

causing apoptosis of cancer cells. Interestingly, there was significant difference between the mean values of 

PN508 and the controls (P < 0.05) which further suggested that PN508 is a potent inducer of Bax and 

therefore could cause apoptosis of cancer cells more efficiently than aspirin and other aspirin analogues 

investigated in this study. This finding is relevant and could serve as a basis for its consideration in designing 

new drugs for the treatment of cancer. However, there is need to investigate further the cytotoxicity of this 

novel aspirin analogue as this could not be established in this study.  In addition, this study is the first to 

investigate the degree of Bax induction on SW480 cells treated with this novel aspirin analogue and therefore 

reference could not be made to any previous study.   
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Comparative analysis of aspirin and novel aspirin analogues 

Bax induction is an early marker of cell apoptosis and the extent of Bax expression corresponds well with the 

number of apoptotic nuclei (34) suggesting that the degree of Bax expression also determines the potency of 

each compound at inducing apoptosis of cancer cells. The degree of Bax expression of aspirin and novel 

aspirin analogues from this study (Fig 3A-3B) therefore suggest variations in potency of each compound at 

producing apoptosis when exposed to cancer cells. 

PN517 and PN529 showed 70-80% fold increases in Bax expression compared to aspirin with 60--70% fold 

increase. This suggests that these novel aspirin analogues are better inducers of Bax than aspirin and therefore 

more potent at inducing apoptosis of cancer cells than aspirin.  This finding may be relevant in designing a 

new drug for cancer therapy. However there is need for further investigation into other properties of these 

compounds such as the cytotoxicity and the mechanism underlying the induction of Bax as these could not be 

established in the present study. 

In addition, the result of this study shows that PN508 causes 100-120% fold increase in Bax expression 

compared to aspirin, PN517 and PN529 which showed 60-70% and 70-80% folds increases in Bax expression 

respectively (Fig. 3A-3C). This suggest that PN508 is the most potent at inducing Bax in cancer cells than 

aspirin, PN517 and PN529 hence could cause better apoptosis of cancer cells than all the other compounds 

investigated in this study. This finding may also be relevant in designing a new drug for cancer chemotherapy. 

However the mechanisms underlying the induction of Bax with this compound needs to be investigated 

further as this could not be established in this study.   

Furthermore, Irinotecan has long been used in the treatment of colorectal cancer and other neoplasm because 

it causes apoptosis of cancer cells (35, 36). This serves its basis for use as positive control in this study while 

Dimethylsulfoxide used as negative control was chosen to neutralize its effect on all the stock solution of 

compounds prepared with it for use in this study.  More interestingly, a marked difference of 50-60% fold 

increase in Bax induction was observed between the negative and positive control (Fig. 3A-3C) demonstrating 

the reliability, robustness and reproducibility of the experimental method used in this study and therefore 

provided the best basis for comparism between aspirin and its novel analogues. 

CONCLUSION 

The result from this study showed evidence of 60-70% fold increase in Bax expression on exposure of SW480 

cells to 0.5mM aspirin at 370C for 48 hours. In addition it is also evident from this study that o.5mM PN517 

and PN529 SW480 treated cells produced 70-80% folds increases in Bax induction at 370C for 48 hours and 

are better inducers of Bax compared to aspirin. More obviously, 0.5mM PN508 is more potent than aspirin, 

PN517 and PN529 at inducing Bax with a significant of 100-120% fold increase on SW480 treated cells at 

370C for 48 hours. These findings may be relevant in designing alternative drugs for the treatment of 

colorectal cancer and other neoplasm. 
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